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NEWS AND ANNOUNCEMENTS 

• APPLE ANNOUNCEMENTS 
Macintosh Holiday Special 
They're here. Now through January 9, 1987 you can buy a Macintosh 
bundled with an Imagewriter II for $95 less than you could buy the two 
items separately. In addition to the Imagewriter dot matrix printer, the 
Holiday Special includes MacWrite (word processing software) and 
MacPaint (free-hand drawing software). And there's more. While 
supplies last, Apple is throwing in MacLightning, an interactive 
spelling checker, as well as a special University Support Kit. This kit 
has 3M cleaners, notepad, diskette storage box, and DiskWriter pen as 
well as a coupon for disks. What is the University Price for these 
Holiday Specials? 

tl Enhanced 512K Macintosh, Imagewriter II, and ... 
tl Macintosh Plus, Imagewriter II, and ... 

LaserWriter Price Reduction 

$ 1430 
$ 1770 

The University prices for the LaserWriter have been reduced. The 
LaserWriter is $330 less; the LaserWriter Plus is $300 less. There's 
been no price change for the LaserWriter to LaserWriter Plus upgrade 
kit What is the new University Price? 

tl LaserWriter 
tl LaserWriter Plus 

• LOTUS UPGRADE OFFERS EXPIRE 
This announcement is a reminder and a warning. 

Version 2 Upgrade 

$3165 
$3735 

Registered Lotus 1-2-3 Version JA owners can upgrade to Version 2 
and can buy the Version 2 upgrade at the Book Center in Williamson 
Hall for $85. This upgrade is available only through December 31st. If 
you don't get your upgrade by December 31st and ultimately decide you 
want Version 2, you will be treated like a new buyer. If you cannot 
decide if Version 2 will be useful to you, the Lotus 1-2-3 review in the 
April1986 Microcomputer Newsletter might help you decide. You can 
also look at Lotus 1-2-3 Version 2 in the Microcomputer HelpLine. 

! ©1986UniversityofMiMesaa News and Announcements continued on Page 16 -----
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SURVEY: STRATEGIES FOR 

NETWORKING MICROCOMPUTERS 

If your department has accumulated a number of 
microcomputers, you may be looking for ways to 
make more effective use of the equipment that you 
have on hand As the number of microcomputers in 
your department increases, the idea of somehow 
linking your equipment together becomes more and 
more attractive. For instance, sharing expensive 
resources that are used intermittently (such as laser 
printers) may make more economic sense than buying 
a printer for every computer. The idea of effortlessly 
transferring files from your microcomputer to someone 
else's machine is also attractive (although you may 
fmd the simplest file transfer method is to hand a disk 
to your co-worker). If we believe the vendors, all of 
this (and more) is possible by purchasing a local area 
network to connect our equipment together. Beware. 
Creating a network of microcomputers can involve 
considerable effort and expense, so you need to select 
the right network the first time. 

In this article, we will survey some of the possible 
approaches for interconnecting microcomputers and 
workstations and see how these approaches fit into the 
Information Systems Department's plans for networks. 
(Information Systems is the parent organization for 
Academic Computing Services and Systems (ACSS), 
Health Sciences Computing Services, St Paul 
Computing Services, West Bank Computing Services, 
as well as the Duluth and Morris campus computer 
service centers.) 

Rather than covering specific networks and features, 
we will concentrate on the issue of how your 
equipment can be connected to other computers and 
networks at the University. We hope this article will 
prompt you to think about how your networking 
decisions will fit in with the rest of the University. 
This survey only deals with interconnecting networks, 
and there are many other issues to consider. Look for 
detailed reviews of specific networks in future 
Microcomputer Newsletters. 

Background . 
Before we deal with specifics, there are several basic 
questions about networks that we will answer: 

• ~t is a foca{ area networK.? 
A Local Area Network (LAN) is built out of hardware 
and software. The hardware typically consists of a 
network adapter card (that plugs into an expansion slot 
in your microcomputer) and cables to connect your 
machine to the next person's machine. There are a . 
variety of different LAN hardware schemes, each w1th 
advantages and disadvantages. Some of the popular 

microcomputer LAN hardware schemes include: 
Ethernet, AppleTalk, IDM's Token Ring, and ffiM's 
PC-NET. When selecting a network you must decide 
what services you need from the network, which 
machines you want to connect together, and what 
software you plan to use on the network. 

As is always the case with computers, you need 
software to take advantage of the hardware. LAN 
software and hardware work together to provide you 
with network services such as access to a shared 
printer, shared files or hard disks, electronic mail, 
machine-to-machine me transfer and (sometimes) 
remote login to other computers. For a given type of 
network hardware, there is frequently more than one 
kind of network software that can be used. The 
moral: to connect equipment in a network you must 
provide both compatible hardware and compatible 
software; just because you have the same network 
hardware on all your equipment does not mean that 
the software will work. 

• 'J1rfiat are tlie Umitations of UJtJ.l§ ? 
Local area networks have limitations on the number 
of machines that can be connected to a network:, in 
the length of the network cable (how far apart 
machines can be), and in the software that will work 
with the network. The limits on the number of 
machines and cable length come from the hardware 
that is used in the network:; there is little you can do 
to change these limitations. It is sometimes possible 
to circumvent the hardware limitations of a network: 
by connecting the network to another network: 
through some sort of black box. (See the section 
below on connecting LANs together.) 

Earlier we mentioned that network software can be 
incompatible. How can this happen? Programs that 
work over a network do so by using a set of network 
protocols. These protocols define how a program is 
to communicate with other programs on the network. 
A program running on one machine connected to the 
network: needs the ability to communicate with other 
machines so that it can provide network: services (for 
example: file transfer). To transfer a file ~ver the . 
network, a program running on one machme (~ding 
the file) must communicate with a program runnmg 
on another machine (receiving the file). The rules for 
how the two programs communicate are embodied in 
a set of network: protocols. Alas, there are many 
different (and incompatible) network protocols in 
existence. Because of the differences between network 
protocols, the software' you can run over a network 
depends on which protocols your network supports. 

Hello Minnesota: Connections 
It is comparatively simple to choose a ~e~ork_ to be 
used in isolation. But using a network m lSOlaUon 
may not be as attractive as being connected to 
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everything. For instance, my ideal computing environment is 
one where I can send electronic mail, transfer files, and log on to 
any computer at the University (i.e., remote login) from the 
microcomputer or workstation on my desk. While I can 
accomplish some of my goals by judicious use of a modem, 
using a network is more attractive because networks 

· communicate at higher speeds than modems. In addition, ftle 
transfers tend to be more reliable over a network. A University
wide network can also provide access to services that would be 
too expensive for an individual department to purchase. 

J 
··When you look at a network for your department, consider 
whether or not you want your network to operate in isolation. If 
you decide that you want access to other people's networks and 
campus mainframes from your network, you must take a whole 
new set of considerations into account 

! 
,. :J-fuw ao you connect one .LJ11!J{_to OJUJtlier? 
·• The problem of connecting two LANs together depends on which 
. two LANs must be connected. 1be simplest case is when two 

networks of the same type using the same network protocols are 
to be connected. For example, you may want to connect two 
networks together to work around hardware limits (such as the 
maximum length of a network). We suggested earlier that some 
sort of black box would make this possible. The black box is 
called a router. A router connects two similar protocol networks 
together and passes information between the two networks. 

In many cases you want to connect dissimilar networks together. 
Since dissimilar networks use different protocols, some 
translation of network protocols must occur at the connection 
point between the networks. A gateway passes information 
between dissimilar networks and performs the necessary protocol 
conversion. 

• '»-fiat are tlit University's pfans for connecting LM{§ ? 
If you want to be able to connect your LAN to the rest of the 

· University, you need to know what the rest of the University 
plans to do. Recently, the "Ad-hoc Committee for Networking 
the University" produced a report that outlines the direction that 
the University should take over the next two years. The 
committee was composed of representatives from Administrative 
Information Systems, Telecommunications, Health Sciences 
Computing Services, Academic Computing Services and 
Systems, St. Paul Computing Services, Duluth Computing 
Services, Morris Computing Services, and the ACSS 
Microcomputer Systems Group. 

The committee settled on the TCP/IP family of network 
protocols as being the best solution immediately available for 
interconnecting computers and LANs at the University. The 
committee chose TCP/IP (Transmission Control ProtocoV 
Internet Protocol) because implementations of these protocols are 
available now for the majority of the computers at the 
University. TCP/IP also provides network services such as file 
transfer and remote login. Another factor in the TCP/IP decision 
is that the Supercomputer Center is already using TCP/IP and 
the Ethernet LAN to connect researchers on campus to the 
Supercomputer Center's machines. 

Bear in mind that although the committee's report has been 
accepted by the Information Systems computer centers, the report 
is not yet a University-wide policy. Moreover, the committee's 
report is a statement of direction rather than a document that 
defines how the campus will be networked. In other words, you 
cannot connect to everything today. Because new LAN products 
are being introduced at a very fast pace, it is impossible to 
predict which LANs and protocols we will be using in five years. 
(To be fair, it is also hard to predict which microcomputers we 
will be using.) It appears that if you plan to connect a LAN to 
the ACSS or Supercomputer Center mainframes in the next two 
years, you will probably need the capability to run the TCP/IP 
protocols and connect to Ethernet Note that the physical 
connection to Ethernet may be accomplished in a variety of 
ways: a router or gateway from your network to a segment of 
Ethernet cable in your building, to a fiber optic ring, or to the 
University digital phone system's Ethernet service (LANmark). 

Microcomputers and Networks 
Now that we have covered LANs in a general way, let's look at 
some specific networks and machines and see how they fit into 
the long term plans for networking at the University. 

Macintosh 
The LAN most often used with the Macintosh is the AppleTalk 
network. AppleTalk is popular because it is very cheap and can 
be used to share an expensive resource: an Apple LaserWriter. 

Suppose you have an AppleTalk network in your department 
How can you connect to the rest of the University? Since the de
facto standard is TCP/IP and Ethernet, you need a gateway from 
the AppleTalk network to Ethernet You also need some TCP/IP 
software. This hardware and software are currently available. A 
product called the Kinetics FastPath acts as a gateway from 
AppleTalk to Ethernet The Microcomputer Systems Group has 
tested the Kinetics FastPath for the last several months and found 
that it works surprisingly well. The Kinetics FastPath is a 
relatively inexpensive connection to Ethernet on a per-machine 
basis. 1be University price for the Kinetics FastPath is $1600. 
You can have up to 31 Macs (using AppleTalk) connected to one 
FastPath gateway. We have tested one Kinetics FastPath with as 
many as five simultaneous users and did not encounter any 
problems. 

The two pieces of TCP/IP software (Telnet and TFTP) that come 
with the Kinetics FastPath are functional, and we understand that 
revised and improved versions of the software should be available 
soon. Telnet is a program used for remote login, and this version 
of Telnet emulates a VT-100 terminal. TFTP is a file transfer 
program. An improved file transfer program (FTP) is said to be 
under development Currently, the Kinetics FastPath appears to 
be the best solution for connecting Macs to Ethernet running 
TCP/IP. 

LANs and the ffiM-PC Family 
For the IBM family there are three fairly popular LANs: the IBM 
Token Ring, the mM PC-Net, and Ethernet Programs that run 
on the Token Ring should also run on PC-Net, because the 
protocols used by software that runs over the network are the 



same for both networks. Unfortunately, the network protocols 
used by ffiM's networks are incompatible with TCP/IP. Perhaps 
sometime in the future a gateway from the ffiM networks to 
Ethernet with TCP/IP software will be available. Right now, 
there is no such gateway. 

The other popular LAN for the mM is Ethernet A number of 
companies have Ethernet products for the ffiM-PC family: 
3COM, Micom/lnterlan, and Bridge Communications come to 
mind. 3COM is representative of the Ethernet offerings for the 
ffiM-PC: 3COM makes an Ethernet interface (network adapter) 
card that costs around $650. (You must install one card in each 
machine on your network.) TCP/IP software (Telnet for remote 
login and FIP for file transfer) has been available for several 
years and works very reliably. If you already have an Ethernet 
LAN in place, you may need a router to connect to the campus
wide Ethernet. 

Workstations 
TCP/IP software is available for most scientific and engineering 
workstations, and an Ethernet interface is frequently a standard 
workstation feature. All SUN workstations come with an 
Ethernet interface built into them. Furthermore, TCP/IP software 
is a standard part of the UNIX BSD 4.2 operating system that 
comes with SUN workstations. In the Microcomputer Systems 
Group, we have been using a SUN workstation and TCP/IP 
software to communicate with ACSS mainframes and 
Supercomputer Center machines. We used the software for 
several months without any problems. 

The Apollo Domain workstations use their own proprietary 
token ring network, but an Ethernet interface is available. We 
have ordered an Ethernet interface for one of our Apollo 
workstations but have not yet received it Again, TCP/IP 
software is available as part of the UNIX BSD 4.2 operating 
system. Both the DEC MicroV AX and mM RT workstations 
have Ethernet interfaces and TCP/IP software available. We plan 
to evaluate these machines over the next few months. 

Conclusions 
If you are looking into setting up a local area network in your 
department, you should take into account whether or not 
machines on your network will need to access other computers at 
the University. If you want to connect your network to 
equipment outside your department, this will affect the network 
you choose, since gateways to the interdepartmental networks are 
not available for all LANs. We would be happy to talk to anyone 
who is considering installing a network about their options in 
more detail. Call or visit us at the Microcomputer HelpLine. 

REVIEW: MORE 

Living Videotext, Inc., the makers of 
ThinkTank (outline software for the ffiM and 
the Macintosh), have created another package 
for the Macintosh, MORE. MORE picks up 
where ThinkTank left off. In· this review, we 

will look at Version 1.0 of MORE and how it differs from 
ThinkTank. 

To use MORE you need a 512K Macintosh or a Macintosh Plus. 
If you use single-sided (400K) disks, you will also need an 
external disk drive. 

Using MORE's Outline 
Creating an outline using MORE is simple. When you create an 
outline on paper you indent each line as your ideas become more 
specific. MORE automates this process. 

MORE's main heading is referred to as the "Home headline." 
Each indented line below the Home headline is called a 
subheadline. You can have only one Home headline. In the 
example below, "Macintosh Plus" is the Home headline and all 
the other lines are subheadlines. Following the same line of 
thought, "external disk drive" is a subheadline to "hardware." 

+ Macintosh Plus 
+ hardware 

- external disk drive 
- Imagewriter II 
- SCSI hard drive 

+ software 
- MacWrite 
- MacPaint 

+ accessories 
- carrying case 
- mouse pad 

Your first step in creating a new outline is to select New ... from 
the File menu. Then you type a headline title, such as 
Macintosh P !us, into the Home headline. Because you can 
have only one Home headline, MORE automatically indents the 
next line after you press the Ret urn key. The next line you 
type will be a subheadline. Thereafter, when you press the 
Return key, the cursor automatically aligns under the previous 
line. In our example since we want the next line C'extemal disk 
drive'') to be a third subheadline, we selected Right from the 
Reorganize menu. 

You can move any subheadline from one place to another by 
selecting it and dragging it to a new location. This feature can be 
very helpful for reorganizing thoughts and ideas. The Home 
headline is the only headline that cannot be moved. 

Head and subheadline lengths in MORE are preset to 127 
characters. If you need to enter more than 127 characters, or if 
you want to place a picture under a headline, you can select 
Expand Document from the View menu. Expand Document 
opens a window into which you can enter additional text or 
pictures. We not only created the outline for this review with 
MORE, but also wrote most of the review in MORE using the 
document windows. 

MORE operates entirely in RAM memory. The only restriction 
on the length of anything MORE creates is the amount of 
available memory (RAM). This means that you can create much 



larger outlines on a Macintosh Plus than on a 512K Macintosh. 
This does not imply that 512K owners are limited to small 
outlines. This entire review, with its text and pictures, used less 
than lOK. You can monitor how much RAM memory is still 
available. To check how much memory your outline is using, 

i select About MORE ... from the tl menu. 
I 

I, Although you can enter text into the document windows, MO~ 
is not a full-fledged word processor. You can transfer the outline 
to a word processing package, such as Microsoft Word or 
Mac Write, for additional formatting. Use Export To ... from the 
File menu to transfer outlines in their own format to MacDraw, 
Jazz, ThinkTank (IBM and Macintosh), Microsoft Word, and 
MacWrite. You can, of course, copy outlines to the Clipboard 

! and paste them into another package. 

J As you become more proficient at using MORE, you can ~ 
keystroke combinations to perform almost every menu selection. 

, MORE comes with a Quick Reference Guide that lists these 
various shortcuts. 

Other Features 
Besides being a good outline package, MORE has other features 

; that make it attractive. It is these extras that differentiate MORE 
from ThinkTank. 

If you create a lot of project or "things to do" lists, MORE can 
make managing them easier. You can create an outline 
representing the days of the week and then list the various tasks 
to be performed under each day. As you complete the tasks, you 
can flag them using the Mark command in the Reorganize menu. 
At the end of the day you can select all your completed tasks and 
remove them or put them under a different subheadline. Any 
uncompleted tasks can be moved to the next day's list. 

• Charts 
If you maintain organizational charts, you1llike MORE's 
charting capabilities. MORE converts outlines into vertical or 
horizontal tree charts. This feature can also be useful for creating 
visual project schedules or time lines. We used part of the 
outline shown on the previous page to create the example below. 
We simply selected Tree Chart from the View menu. 

I Macintosh Plus J 

I hardware ] I software ) ( accesscries 

I MacWrire J ( MacPaint 
J 

You can also create bullet charts (shown in the next column) to 
emphasize key points in presentations or documentation. 

Macintosh Plus 

• hardware 
• software 
• accessories 

To modify the appearance of both bullet and tree charts, you use 
the Format menu and the on-screen palettes; these let you select 
the shape of the boxes, line width, and more. 

• Multiple Windows 
You can have up to six windows from different files open at the 
same time. This can be very handy if you need to cross-reference 
ideas and material. Using multiple windows, you can easily 
move information from one outline to another. You can arrange 
the open windows using the options in the View menu. 

• Templates 
If there are outline styles that you use on a regular basis, you can 
save the style as a template. Whenever you need to reuse that 
outline style, you can select it from the Templates menu. 
Eliminating typing the same information repeatedly can save you 
a lot of time. The MORE disk includes some frequently used 
templates already created for you, such as one for an address file. 

• Calendar 
MORE also has a calendar that lets you select a range of dates 
and time increments (minutes or hours). Once you've made your 
selections, MORE automatically inserts the days with the time 
breakdown into your outline. This can be helpful for managing 
schedules and appointments. We created the example below in 
about five seconds. 

+ Vacation Schedule 
+ Calendar 

) 

+ Week of Sunday, September 28, 1986 
+ Wednesday, October 1, 1986 

- 9:00 AM 
+ Thursday, October 2, 1986 
+ Friday, October 3, 1986 
+ Saturday, October 4, 1986 

+ Week of Sunday, October 5, 1986 
+ Week of Sunday, October 12, 1986 

Shortcomings 
If you work with Macintosh softw;u-e on a regular basis, you 
expect certain features to be in specific menus. For example, 
when you print from Mac Write you know that Page Setup ... is 
under the File menu. Although MORE's Page Setup ... is under 
the File menu, Print Options ... is under the Format menu 
(instead of the File menu where we expected it). You select your 
outline's spacing and label format from Print Options ... If you're 
like us and you select Print ... from the File menu without 



checking the manual or the other menu options, you may get 
some unexpected results when you print your outline. This is 
more of a quirk than an actual problem. 

MORE does not provide on-screen help; this would have been a 
useful feature, especially for access to command key shortcuts. If 
you do need help, you can turn to the manual. The manual is 
clearly written and has a very good index and examples. 

The only other problem we found is that MORE has no Undo 
command. You can use a Revert command which reverts back to 
the last saved version of the document, but Revert is not a 
substitute for the Undo command. For example, suppose you 
made numerous changes to your outline and then made a mistake 
(like selecting Clear instead of Copy). What you really want is 
to "undo" the mistake. The only option MORE gives you is to 
select Revert, but by doing so you lose all of your changes since 
the last time you saved your document 

Conclusion 
MORE is an excellent package if you need a good outliner as 
well as the additional features that MORE has to offer. If you 
have limited use for MORE's charting capabilities and need just a 
basic outline package, ThinkTank may be a better value for you. 
If you are a chronic list maker, MORE can make your 
organizational tasks easier to manage. Even if you are 
completely unorganized, MORE may help by providing some 
structure to your thoughts. 

The Electronics Desk in the Williamson Hall Book Center will 
special order MORE for $165. If ThinkTank is more suited to 
your needs, the Book Center can order it for $112. You can 
inspect both packages at the Microcomputer HelpLine. 

REVIEW: NORTON UTILITIES 

Do you have nightmares about 
accidentally erasing your thesis from your 
floppy disk or all files from your hard 
disk? Have you ever accidentally erased an 
important document late at night? Or 
have you or anyone you know lost files 
because of a damaged disk? Don't panic. 
Norton Utilities may have a cure for 
hopeless, helpless, and desperate IBM PC 
users. The Norton Utilities, by Peter 
Norton Computing Inc., may be able to 
recover your lost data. 

The Norton Utilities, version 3.10, is a set of 18 utility 
programs that was first introduced in 1982. These utilities 
supplements your mM (or compatible) opemting system's ~S 
commands. The Norton Utilities can be divided into three mam 
groups: file and data recovery, security for confidential 
information, and hard disk management aids. 

To use the Norton Utilities, you need an IBM personal computer 
or compatible, at least 128K of RAM (the Norton Utilities 
manual recommends at least 256K), and DOS version 2.0 or 
higher. Most of the utilities will work with any flavor DOS, but 
you should read the Compatibility Notes in the Norton Utilities 
manual to see if your operating system is compatible. 

Version 3.10 versus 3.0 
Version 3.10 is the most recent upgmde for Norton Utilities. It 
differs from 3.0 in several significant ways. Version 3.10 has 
two new utilities: Quick Unemse and Unremove Directory. 
Quick Unemse recovers erased files, and Unremove Directory lets 
you restore subdirectories removed with the DOS RMD IR or RD 
commands. Version 3.10 also lets you work with files in many 
directories. 

Using Norton Utilities 
The Norton Utilities package consists of one main utility, which 
recovers lost data, and 17 other utilities. We will call the whole 
package by its full name, the "Norton Utilities," and the data 
recovery utility by its short name, "NU." 

To use the Norton Utilities, you need to type the name of the 
utility you want to use. Most of the names are preset to two
letter names. Those short names are easy to type but aren't 
always easy to remember. The Norton Utilities lets you use a 
command called LONG to change the short names to long names, 
such as FILESIZE, instead of FS. 

• Recovering an Erased File 
To recover a file you accidentally erased, your first step generally 
would be to type NU to start the me recovery utility. Once you 
type NU, you are presented with a four choice menu. From this 
menu you select Recover Erased File. Once you select Recover 
Erased File, NU moves you to the menu shown below. 

Recover Erased File 
Choices: 
fl Change Selected Drive or Directory 
£2 Select an Erased File to unErase 
f3 Display Information about Erased File 
f4 Find Erased File's Data 
f5 Save unErased File 
esc Return to Top Level Menu 

Since it's unlikely that the me you want to recover is on the 
same disk as the Norton Utilities software, your next step is to 
tell NU where the erased me was stored. To do this you choose 
Change Selected Drive or Directory from the Recover Emsed File 
menu. After you've told NU where your me was stored, you tell 
NU what file you want to recover. To do this you choose Select 
an Erased File to unErase. At this point NU displays a list of all 
the files it could unemse, and you 'Select the me you want 
unerased. 

You're almost done, but you still have two major steps to 
complete. One step selects each cluster of the disk that stored 
pieces of your me. (Data is stored on your disk in units called 
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l clustels.) Yoo can have NU "guess" which c1USiels you need. 
~ Your fmal step is to save your unErased file. 
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Data Recovery 
You can recover files with NU because the DOS Erase and DEL 
commands don't instantly erase data from the disk. Instead when 
you erase a file, DOS allows the space used by that file to be 
used to store other files. 

The Norton Utilities offers you two ways to recover lost data. 
One way is to use the new Quick Unerase (QU) utility. QU lets 
you easily restore a file immediately after you have erased it If 
you save anything new to your disk (or revise existing 
infonnation), you risk overwriting the parts of the disk where 
your erased file was stored. QU will not work if your lost file is 
overwritten by another file. If your file is overwritten, or if you 
lost your file because the disk was damaged, you must use the 
recovery utility called ''NU." NU is the utility we expect people 
to use most frequently. 

NU is most useful when the file you want to recover is a text 
file. You can ask NU to search for a specific phrase, such as 
"must return this by June 30th," you used in a previous version 
of your file. If you don't search for specific data, NU always 
recovers the last version you saved. NU cannot always recover an 
entire ftle. You may find using NU worthwhile even if it only 
recovers a part of a big text file. We edited and saved a 76K text 
file several times and then erased it NU had no problems 
recovering the last version of the file we saved. 

If the file you want to recover is highly structured, like Lows 
worksheet files, we don't expect NU to be useful to you unless it 
can recover the whole file. 

Data Security 
As we discussed earlier, the DOS Erase or DEL commands 
don't completely erase data from disks. This means that 
confidential infonnation you erased can be recovered with 
software such as the Norton Utilities. If you want to be sure no 
one can read (recover) files that you erased, you can use the 
Norton Utility called WIPEFILE. WIPEFlLE overwrites the 
parts of the disk that your file was stored on with blank 
infonnation. 

Even refonnatting a disk does not insure that no one can recover 
your data. The DOS Format command does not actually 
overwrite all data on an entire disk under all circumstances. The 
Norton Utility called WIPEDISK writes zeroes into every sector 

~ of the disk, thereby wiping out the entire contents of a disk. 

1 

Hard Disk Management 
Some of the Norton Utilities help you manage your hard disk 
more easily than you can with the DOS commands alone. These 
utilities can be especially useful if you have many subdirectories 
and files with similar filenames. Some of the things you can do 
with the Norton Utilities include: fmd a file without knowing 
which subdirectory it was stored in, search for a particular phrase 
or string of characters throughout an entire disk, alphabetize your 
directory, protect a file so you (or someone else) cannot 

accidentally erase it. and test your disk to see if parts of it are 
damaged. Although some utilities are similar to DOS 
commands, they do more. Norton Utilities is also more 
forgiving, that is if you don't supply the right qualifiers or 
syntax, the software prompts you for answers. 

One management utility is Disk Test. You can use Disk 
Test (Dl) to test your disk to see if it is damaged. If DT 
discovers that parts of the disk have gone bad since you last 
formatted it. DT marks those portions of the disk as "bad 
sectors." DOS won't use these "bad sectors" to store any 
infonnation; it skips over them and writes your infonnation on a 
good part of the disk. You could, of course, use the DOS 
Format command to mark those "bad sectors," but using DT 
requires less work. If you use DT you won't have to back up all 
your files, reformat your disk, and recopy all your files back onto 
your hard disk. 

Getting Help 
The Norton Utilities manual doesn't have an index, so it can be 
difficult to quickly find infonnation on the 18 utilities. The 
manual doesn't have good examples, which is very important for 
novice DOS users. Instead of showing you how to enter 
commands, the manual shows the final fonnat of each command 
in a DOS-like manner. The manual does not describe the menus 
and all their levels. Since it's very easy to get lost in the on
screen menus, we believe that the manual should have provided 
more information. The manual does have a useful Tips and 
Suggestions section following every command. The author 
suggests why and how you may use the commands, and he 
shares with you his own computer experience. Generally, the 
manual is adequate for the advanced users, but inadequate for 
beginners. 

The Norton Utilities don't provide you with on-screen help, but 
if you are unfamiliar with the utilities or forget a utility's name 
or purpose, you can use the Reference Summary card that comes 
with the package. This reference card lets you quickly find what 
you need. 

Conclusion 
Even if you accidentally delete only one important file, you may 
be glad you bought the Norton Utilities. In addition to restoring 
lost files, the Norton Utilities can protect your confidential data 
from accidental or intentional eavesdropping, and help you 
manage your hard disk. We believe some people will benefit 
from using the software. 

You can order the Norton Utilities from the Book Center in 
Williamson Hall for $60. To upgrade to version 3.10 from any 
previous version of the Norton Utilities costs $25. Call Peter 
Norton Computing Inc. at (213) 453-2361 to order an upgrade. 

You can look at version 3.10 of the Norton Utilities in the 
Microcomputer HelpLine. 



Announcements continued from page 1 ----
Version 2.01 Upgrade 
Registered owners of Lotus 1-2-3 Version 2 can buy this newest 
release, Version 2.01, for $20 from the Book Center. Lob.JS is 
making this 2.01 upgrade available only through December 31st 

Although the Microcomputer HelpLine ordered Version 2.01, as 
of press time we do not have iL We understand Version 2.01's 
changes improve compatibility with Lotus 1-2-3 1A ftles ''but 
will not affect any adjustments you have already made in 
converting worksheets from Release 1A to Release 2. (There is 
one possible exception ... )." 1be exception occurs when the 
worksheet relies on a "mixed formula reference resulting in ERR 
in your Release 2 worksheet" In that case, Version 2.01 may 
"require you to adjust some macro applications and @IF 
formulas that compare or search for particular labels, since 
labels, zeroes, and blank cells now equate to the value zero." 
Other Version 2.01 changes include simplified installation and 
allowing negative and fractional arguments with @PMf, @PV, 
and @ FV financial functions. 

Contact the Lob.JS Upgrade Program at 617/253-9186 if you 
want more information. 

• ffiM AT POWER CORD REPLACEMENT 
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About 1400 ffiM PC AT power cords 
may have a bad solder connection; 
under some circumstances they could 
shock people. The suspect power cable 
could be used for displays, printers, or 
other personal computers. mM will 
replace these suspect AT power cords at 
no cosL 
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after September 1, 1985, maybe. 
Examine our illusttation. Inspect the 
cord. If the power cord on your mM 
AT has all four of these features, then 
the cord should be replaced: CD a 
stackable right angle plug, ® the code 
stamped on one metal prong is "J7" 
® while the code stamped on the 
second metal prong is one of these 
pairs of characters- ON, AO, BO, 
CO, DO, EO, AP, BP, or CP- and 
® the characters stamped on the 
exterior of the cord are "1501677 18-3 
TYPE SJT E-3462-C LL-30830 
SHIELDED." 

Through December 31, 1986 ffiM will handle replacing the 
suspect cords through a Power Cord Replacement Program. So, 
through December 31st you can replace AT cords by writing to: 

ffiM Corporation 
Power Cord Replacement Program 
P. 0. Box 56, Batavia, IL 60510 

and giving ffiM the following information: 
a your full mailing address 
a your mM AT machine serial number 
a the prong codes for each AT requiring a replacement cord 
a a signed statement with the following wording: I agree to 

destroy the original cords on receiving the replacement cords. 

After January 1, 1987 you can still get suspect AT power cords 
replaced without charge, but the cords must be obtained through 
normal parts ordering procedures. If any lettering on the power 
cable or plug is illegible and you are concerned that the cable is 
defective, contact ffiM as instructed above. mM will replace the 
cord without charge. 

e PC PILOT UPDATE 
PC PILOT, ffiM PC computer-aided instruction (CAl) authoring 
system software, has been updated. Version 3.0 is now available 
free-ofcharge to Project WOKSAPE participants. Those 
interested in obtaining the update should bring two blank, 
formatted disks to the Microcomputer HelpLine. The new 
version of the manual is also in stock at the Book Center in 
Williamson Hall and may be purchased for $20. 

• WORDPERFECT 4.2 UPGRADE 
We've ordered our upgrade; you can order one too. If you have 
WordPerfect Version 4.1 you can get the 4.2 upgrade for $35. If 
your version is 4.0 or older, then the 4.2 upgrade costs $60. If 
you bought WordPerfect 4.1 since October 1, 1986, then the 4.2 
upgrade is free if you send in your receipt; this free upgrade offer 
expires February 28, 1987. To get the upgrade you must do these 
three things: <i> let WordPerfect know which machine you plan 
to use WordPerfect on (such as an IBM PC),® send 
WordPerfect the title page from your WordPerfect manual, and 
@send WordPerfect the upgrade fee. Mail all this to: 

WordPerfect Corporation 
288 West Center Street, Orem, Utah 84057 

We don't have a list of the 4.2 enhancements, but we understand 
that the new features include the ability to add non-printing 
comments to a document, a document summary feature which 
allows you to include the author, typist and some document 
description with WordPerfect files, and a bigger dictionary and 
thesaurus. If you have questions about the upgrade, you can call 
WordPerfect's information number at 801-225-5000. 

• SOFfW ARE SITE LICENSES 
I The Present 
1be University currently owns site licenses for the five 
microcomputer software packages listed below. Some of the 
money to buy these licenses came from Academic Computing 
Services and Systems (ACSS); most of the money came from 
Project WOKSAPE. 

1. SPSS/PC+ (IBM personal computers): basic system and 
graphics system 

2. IMSL (IBM personal computers): Math/PC Library and 
Statistics/PC Library 
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3. TI Personal Consultant Plus (IBM personal computers) 
4. TRACER (IBM personal computers) 
5. SYSTAT (IBM personal computers and Apple Macintosh) 

Any University department (not individual faculty, staff, or 
students) can lease these five software packages. To lease the 
software departments must pay an initial fee and an annual 
renewal fee. The initial fee includes the cost of using one copy of 
the software for the first year. Departments that want to continue 
their site licenses from year to year must pay an annual fee. To 
lease software for which the University of Minnesota holds a site 
license Departments must comply with the following procedures: 

0 only departments are able to lease software packages 
0 all initial and annual fees must be paid as per agreement 
0 fees must be paid by Journal Voucher; the ACSS budget 

number the Journal Voucher should credit is 0950-1604-07 
0 software manuals must be purchased separately 
0 disks must be picked up at the Microcomputer HelpLine in 

125 Shepherd Labs during HelpLine hours 
0 departments must sign a Registered Authorized User 

Certificate form prior to leasing each software package 

All software manuals will be available in a special section at the 
Book Center in Williamson Hall. Software disks will be 
available for pick up in our Microcomputer HelpLine. To pick 
up the disks you must present a signed Journal Voucher and sign 
a Registered Authorized User Certificate. The annual and initial 
fees for the site licenses are as follows: 

Software Initial $ Annual$ 
SPSS/PC+ 75 50 
IMSL 75 50 
TI Personal Consultant Plus 295 undecided 
SYSTAT 75 50 
TRACER undecided undecided 

l 
·.,J,J Manuals Book Center Price 

SPSS/PC+ base system $29.95 
At press time, prices for the other manuals were unavailable, and 

·f most manuals are not in stock at the Book Center. 

I The Future 
Vendors such as Ashton-Tate (dBASE) and Lotus (1-2-3) do not 
offer site licenses at the present time. ACSS will continue to 
pursue site licenses for these popular packages as well as for 
other software. Some vendors currently offer instructional 
classroom software agreements at a reduced price, but the 
administration required for this type of agreement makes them 
uneconomic to oversee. 

Let us know what types of software site licenses your department 
would like to lease, and how many leases your department would 
purchase for each software package. Write to the Microcomputer 
Systems Group at 125 Shepherd Labs. 

• SPELLSWELL CORRECTION 
In our November 1986 Microcomputer Newsletter review of 
Spellswell, we incorrectly stated that we used Version 1.7. Our 

version is 12C; Spellswell is currently shipping Version 1.20, 
which corrects some spelling errors they found in their 
dictionary. We apologize for any inconvenience this error may 
have caused you. 

e KURZWEIL OPTICAL SCANNER SERVICE 
The September 1986 ACSS Newsletter carried an article about a 
new ACSS optical scanning service. Most of that article is 
excerpted below. 

The Kurzweil4000 can read both typed and typeset copy, 
including proportionally spaced text, and it identifies and codes 
font changes within typeset material. The system recognizes 
mathematical and scientific symbols, accented and other non
English European language characters, typesetting conventions 
such as ligatures, right and left quotation marks, and em and en 
dashes. The Kurzweil 4000 can create either an ASCII or 
EBCDIC flle from the scanned text 

We envision three broad categories of use for the Kurzweil 
scanning service on campus, in both academic and administrative 
settings. Creating: 

• computerized text flies from printed materials for further 
processing (such as editing, formatting, merging with existing 
text flies) and/or publication onto paper or electronic media 

• computerized text flies from printer materials for library-type 
storage, reference, and retrival 

• textual databases from printed material for research and analysis 

A scanning job involves three activities: 

• Development of a machine training set, in which the Kurzweil 
is "trained" to recognize most of the letterforms in a document 
and which takes 15 to 20 minutes for most documents. 

• Processing, in which unidentified characters can either be 
passed over, flagged, or presented for correction. In the fastest 
mode the scanner can handle 40 to 60 pages per hour. 

• Communication of the scanned text to the user's media. 
Options at ACSS will be a Zenith 150 (ffiM-PC compatible) 
disk or a VAX/VMS or CYBER account 

ACSS's Kurzweil 4000 scanning service is located in 128B Lind 
Hall, under the direction of Carol Winther. Users can either do 
their own scanning after a two-hour personal training session, or 
have ACSS perform all the work. Initially scheduling will be by 
appointment. Contact Ms. Winther at 625-9525 between 10:00 
a.m. and 12:00 noon, Monday through Friday. 

Currently rates are set at $15 per hour for university and non
profit accounts and $30 per hour for other accounts when users 
do the scanning, plus $30 for personal training for both groups . 
With ACSS doing the scanning, charges are $30 per hour for 
university and non-profit accounts and $45 for other accounts. 
ACSS grants can be used to pay for the service. 
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MICROCOMPUTER 
SYSTEMS GROUP 

phone-in First Aid for 
microcomputer users 

since 1980 

• can our HelpLine 
626-4276 

(dial MA MICRO) 

• VIsit our HelpLine 
Room 125, Shepherd Labs 

East Bank Campus 

• We're Available 
9 a.m. -12 and 1:30-4 p.m. 

Monday 
Tuesday 

Friday 

9 a.m. through 4 p.m. 
Wednesday 

Thursday 
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